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1 硬件配置 

1.1 端子接线 

SV-DA200CoDeSys 伺服驱动器的 CN3 端子为通讯以及仿真器接口。CN3 为双 RJ45 插座，上下两个插座

的引脚排列顺序是相同的。如果需要用到全功能，需要将 CN3 网口的线都引出来分接到 485、CAN 等； 

引脚示意图及功能表如下： 

 

CN3 端口功能表 

引脚号 名称 功能 备注 

1 CANGND 电源 485 为 Modbus 从站和外接触

摸屏等通讯；CAN 作为主站和

其他 DA200-E 型伺服通讯；

CoDeSys485 作为仿真器接口

和CoDesys开发环境惊醒通讯

实现仿真下载功能。 

2 485GND 电源地 

3 CoDeSys485- CoDeSys485- 

4 RS485+ RS485 数据线+ 

5 RS485- RS485 数据线- 

6 CoDeSys485+ CoDeSys485+ 

7 CAN_L CAN 数据线- 

8 CAN_H CAN 数据线+ 

1.2 波特率设置 

CAN 各种波特率以及对应的最大传输长度，如下表： 

通讯波特率 通讯长度 

1Mbit/s 25m 

500kbit/s(默认)  100m 

250kbit/s 250m 

125kbit/s 500m 

50kbit/s 1000m 

20kbit/s 2500m 

1.3 注意事项 

1. CoDeSys CAN 没有内置终端电阻，带其他 CAN 伺服时需要外接一个或者两个终端电阻，一般在主站和

最后一个及节点外置； 

2. CAN 波特率建议设置成 500bit/s，长度和抗干扰措施都比较合适。 

3. 为避免干扰，CAN 连接线最好采用屏蔽双绞线。 
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2 软 PLC 功能及架构 

2.1 软 PLC 伺服具备的功能 

1. 本机兼备 DA200 标准伺服的基本功能； 

2. 可以通过 485 接口进行 PLC 程序的下载、断点仿真等； 

3. 具有基本 PLC 逻辑控制以及定时器等基本功能，支持多种 PLC 编程语言； 

4. 可以作为 485 从站和外界通讯，传递伺服本身参数以及 PLC 内部参数； 

5. 可以作为 CAN 主站控制其他 DA200-E 型伺服以及读取其他节点参数； 

6. 可以快速读取本机及其他伺服故障码，发现主机或者从机发生故障后可以让所有伺服自动停机保护； 

7. 可以配置主站和从站的心跳时间，在发现断线情况下，主从伺服自动停机保护； 

8. 可以通过读写功能块快速读写本机伺服的参数； 

9. 可以通过功能块操作脉冲输出； 

10. 可以通过功能块操作模拟量输出； 

11. 可以通过添加 IO 设备读取 IO 输入状态以及控制 IO 输出； 

12. 具有参数掉电保存区域。可以实现参数的保存； 

13. 在 PLC 程序出现问题导致伺服启动不了可以一键擦除（按住 Mode 键启动）PLC 程序恢复伺服初始状态； 

2.2 系统架构图 

 

图 1 系统架构图 

如上图： 

1. PLC 开发人员通过 CoDeSys485 通讯编辑和仿真 PLC 软件； 

2. 用户可以通过 485 从站接口通过触摸屏对伺服参数或者 PLC 参数进行读写； 

3. 通过 CAN 总线，CoDeSys 伺服可以控制其他 DA200 CAN 型伺服。 
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2.3 PLC 功能的存储空间 

代码区域 131072 字节； 

数据区总共 192512 字节； 

     IN 和 OUT 变量区域 1280 字节； 

其他变量区域 191232 字节； 

掉电保存区域数据 400 字节。 
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3 CoDeSys 软 PLC 功能 

3.1 CoDeSys 软件安装 

 从 CoDeSys 官网或者其他途径选择安装 CoDeSys 的最新版本； 

 或者从下面链接下载： 

 https://pan.baidu.com/s/1kVtAkcB 

 

 得到安装文件后直接按照默认设置安装； 

3.2 库文件及设备描述文件安装 

3.2.1 相关文件 

DA200 CoDeSys 相关配置文件有以下几种： 

 

Gateway.cfg：CoDeSys 仿真通讯接口设置； 

INVTServoLib.library：INVT 功能块； 

INVTServoSoftPLC.devdesc.xm：INVT 软 PLC 设备描述文件； 

IoDrv_SHINVT.devdesc.xml：INVT IO 设备描述文件； 

IoStandord3.5.5.0.projectrchive：标准的 3.5.50IO 库文件，运行 PLC 的必须库。 

DA200CodeSysLIB20170728.compiled-library：INVT 单轴伺服控制库。 

temp00.project：例子工程。 

3.2.2 Gateway.cfg 使用 

Gateway.cfg 内容如下： 
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需要根据 CoDeSys 的串口号来更改文件中的串口号； 

改完之后将这个新的 Gateway.cfg 替换 CoDeSys 原来的 Gateway，地址如下： 

 

 

3.2.3 设备描述文件安装 

打开 CoDeSys，Tools→Device Repository；安装设备描述文件； 
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3.2.4 库文件安装 

打开 CoDeSys，Tools→Library Repository；安装相关设备库文件； 

 

注：其他库安装类似。 

3.2.5 安装 IoStandord 库 3.5.5.0 

直接双击该文件会自动进行库文件的安装； 

 

 

3.3 新建 CoDeSys PLC 工程 

3.3.1 新建空工程 

CoDeSys 菜单栏→File→New project；选择新建空白工程； 
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3.3.2 添加 PLC 设备 

Device 窗口选择项目名右键→Add Device，从里列表中选择 invt plc； 

 

 

3.3.3 添加 IO 设备 

如果需要使用伺服的 IO 输入或者输出，需要添加该设备； 

选中刚添加的 PLC 设备，右键→Add Device，从列表中选择 invt io 设备； 
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配置 IO 设备的调用周期：选择 PLC，在 Device→PLCSetting→Always update variables 中设置； 

 

 

3.3.4 添加库文件 

 选择 Application→library manager 中 Add library 添加 invt 的功能块库； 
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3.3.5 设置工程断电保存 

 

设置这个选项后程序才会下载到 Flash，否则则会运行在 ram，重启后程序会丢失； 

3.3.6 添加代码 POU 并关联到任务 

选择 Application，右键→Add object→pou； 

 

添加好 pou 后，在 task configuration 中 Add object→add task； 

按照图示设置 PLC 任务的循环周期，并在任务调用里添加刚才新增的 pou； 
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3.3 CoDeSys 控制 IO 输入/输出 

3.3.1 参数设置 

需要用到开关量输出时需要将伺服对应的开关量功能设置为无效，然后通过开关量模块对开关量输出进行控

制，设置如下： 

 

 

3.3.2 开关量输入 

根据前面步骤 3.2.3 中添加 IO 设备后，在界面上会显示开关量输入和开关量输出； 

开关量输入是只读的；如下图对应 10 路输入：分别为 0-9； 
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3.3.3 开关量输出 

要控制某个开关量时只要往对应开关量输出位里面写值即可；下图示例将开关量输出 1、3、5 置成高电平； 

 

对应有没有设置成功可以在伺服上位机 ServoPlorer→工具→开关量配置里查看状态；如下图： 

 

 

3.4 CoDeSys 控制模拟量输出 

3.4.1 参数设置 

需要使用 CoDeSys 控制模拟量输出时首先得将模拟量输出参数功能选成无效； 

 

3.4.2 功能块说明 

 

输入参数： 

AIValue：模拟量输出值，单位(mV)； 

AiOutputIndex：模拟量输出通道号；0 代表模拟量输出 1，1 代表模拟量输出 2。 

3.5 CoDeSys 控制脉冲输出 

3.5.1 参数设置 

需要使用 CoDeSys 控制模拟量输出时首先得将分频输出来源改成 CoDeSys； 
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3.5.2 功能块说明 

 

输入参数： 

Mode-  0 代表以 Frequency 的频率输出 Distance 个脉冲； 

    -  1 代表一直输出固定频率的脉冲信号；这种模式下 Distance 无效； 

Frequency 代表脉冲输出的频率； 

Distance 代表输出的脉冲个数； 

Run 是触发信号，电平有效； 

输出参数： 

Done 在走 mode0 走完固定脉冲后会置 1 代表执行完毕。 

3.6 读取故障 

3.6.1 功能块说明 

 

输入参数： 

NodeID：CAN 从站节点号；0-126；0 代表读写本机故障，1-126 读取其他 CAN 节点故障； 

输出参数： 

ErrorCode：高 8 位为故障主码，低 8 位为故障子码；具体故障根据说明书来查找； 

注意：读取本机任何时刻产生的故障都能读取，但从机故障读取只能读取主站和从站正常通讯建立后产生的故障；

如果想要完全可靠的读取从站故障，建议使用 SDO 功能读取 R0.99 当前故障。 

3.7 读取本地参数 

3.7.1 功能块说明 

 

输入参数： 

Adress：CANopen 主索引+子索引； 

DataType：数据类型；16、32、64 分别代表 16、32、64 位参数； 

输出参数： 

Value：读取的参数值； 

Result：读取结果，0 代表读取成功；其他值代表读取未成功； 



英威腾 SV-DA200 伺服 CODESYS 软 PLC 技术指南 

8 

3.7.2 读取例子 

 读取参数需要知道参数的地址和数据类型，可以根据说明书查找也可以通过 ServoPlorer(4.14)详细参数窗

口查看；如下图，双击点动速度，查看 CANopen 地址和数据类型；伺服内部参数子索引都为 0。 

 

功能块 Adress 填 0x200500(0x2005+0x00)； 

DataType 填 16(int16); 

注意：为了兼容不同数据类型，将读取的值定义为了 LINT64 位数据，用户需要根据自己需要进行数据类型转换。 
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3.8 设置本地参数 

3.8.1 功能块说明 

 

输入参数： 

Value：参数的设置值； 

Adress：CANopen 主索引+子索引； 

DataType：数据类型；16、32 分别代表 16、32 位参数； 

输出参数： 

Result：设置结果，0 代表设置成功；其他值代表设置未成功。 

3.8.2 设置例子 

 读取参数需要知道参数的地址和数据类型，可以根据说明书查找也可以通过 ServoPlorer(4.14)详细参数窗

口查看；如下图，双击点动速度，查看 CANopen 地址和数据类型；伺服内部参数子索引都为 0。 

 

功能块 Adress 填 0x200500(0x2005+0x00); 

DataType 填 16(int16)； 

设置值填到 Value 中； 

注意：为了兼容不同数据类型，将设置的值定义为了 LINT64 位数据，用户需要根据自己需要进行数据类型转换。 

3.9 读取 CAN 节点参数 

3.9.1 功能块说明 

 

通过 SDO 读取网络中各节点参数；但当 NodeID 设置成 0 时代表读取本机参数； 
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SDO 读取本机参数和上面读取本机参数的区别： 

1、SDO 读取的最大参数是 32 位数据；本机读取的最大参数是 64 位数； 

2、SDO 可以读取本机参数及 CIA301 及 402 协议中的参数，如 0x6061 控制模式反馈； 

输入参数： 

Enable：读取触发开关，上升沿触发一次读取；但当 NodeID 为 0 时该参数无效，即无需触发便会读取； 

NodeID：CAN 从站节点号：0-126；0 代表本机； 

Index：CANopen 参数索引；查看方式同上面的方法； 

SubIndex：CANopen 子索引；如果是伺服自定义参数子索引为 0；如果是 301 或者 402 参数按照协议定义的索

引来设置； 

DataType：数据类型；16、32、64 分别代表 16、32、64 位参数； 

输出参数： 

Value：读取的参数值； 

Result：读取的结果；0 代表读取成功；其他书代表未成功； 

注意：为了兼容不同数据类型，将设置的值定义为了 LINT64 位数据，用户需要根据自己需要进行数据类型转换。 

3.10 设置 CAN 节点参数 

3.10.1 功能块说明 

 

通过 SDO 设置网络中各节点参数；但当 NodeID 设置成 0 时代表读取本机参数； 

SDO 设置本机参数和上面设置本机参数的区别： 

SDO 可以设置本机参数及 CIA301 及 402 协议中的参数，如 0x6060 控制模式； 

输入参数： 

Enable：读取触发开关，上升沿触发一次读取；但当 NodeID 为 0 时该参数无效，即无需触发便会读取； 

NodeID：CAN 从站节点号：0-126；0 代表本机； 

Index：CANopen 参数索引；查看方式同上面的方法； 

SubIndex：CANopen 子索引；如果是伺服自定义参数子索引为 0；如果是 301 或者 402 参数按照协议定义的索

引来设置； 

DataType：数据类型；16、32、64 分别代表 16、32、64 位参数； 

输出参数： 

Value：设置的参数值； 

Result：设置的结果；0 代表设置成功；其他代表未成功； 

注意：为了兼容不同数据类型，将设置的值定义为了 LINT64 位数据，用户需要根据自己需要进行数据类型转换。 
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3.11 PDO 功能 

PDO 功能是速度较为快速的数据读写机制，但默认是不启用该功能的；事先需要设置住从站参数，调用启动同

步 PDO 功能；然后再开启 PDO 数据的读和写。 

3.11.1 主站相关参数设置 

设置主站参数需要使用 ServoPlorer 上位机工具；打开工具→CANopen 参数配置； 

 

 
我们只支持同步PDO传输类型；CoDeSys作为PLC的同时也作为一个虚拟的CAN从站运行CAN的一些控制；

所以需要设置以下参数： 

控制模式：CANopen 模式； 

通讯周期：设置成需要的同步周期；建议 5ms 左右；视从站个数而定； 

PDO 传输类型：改成 1-240，代表每隔 n 个通讯周期传输一次 PDO； 

波特率：视现场应用而定，一般推荐 500kbps，相对稳定而且线距离可以比较长； 

修改完参数后按发送按钮，等发送进度条走完后点击保存参数。 
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3.11.2 从站相关参数设置 

设置从站参数需要使用 ServoPlorer 上位机工具；打开工具→CANopen 参数配置； 

 

 
我们只支持同步 PDO 传输类型； 

所以需要设置以下参数： 

控制模式：CANopen 模式； 

PDO 传输类型：改成 1-240，代表每隔 n 个通讯周期传输一次 PDO； 

波特率视现场应用而定，一般推荐 500kbps，相对稳定而且线距离可以比较长；波特率网络需要一致； 

修改完参数后按发送按钮，等发送进度条走完后点击保存参数。 

3.11.3 PDO 参数映射 

 

1.PDO 参数默认的有一套默认的映射参数，是用于 402 点击控制的，可以运行基本的速度环和点位模式； 

但 PDO 映射是可以根据用户需求进行变更的； 

2.TPDO 代表伺服反馈给 PLC 的参数；RPDO 代表 PLC 设置给伺服的参数； 

3.每个伺服支持配置最大 4 组 TPDO 和 4 组 RPDO； 

每组 PDO 最大 64 字节或者最多 4 个参数； 

4.PDO 配置的内容为 16 位主索引+8 位子索引+数据长度(16 进制)；例如： 

0x60400010 代表 index 为 0x6040,subindex 为 0x00,长度为 0x10（16 位）的控制字参数； 

5.PDO 可以配置常用的 402 参数，也可以配置我们伺服内部的参数；内部参数子索引都为 0。 
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3.11.4 启用同步信号及 PDO 功能 

 

输入参数： 

Enable：功能触发指令，上升沿触发该功能； 

NodeID：1-126，需要启用 PDO 的从站节点号； 

Start：true 代表启用同步及 PDO 功能；false 代表停用同步及 PDO 功能； 

输出参数： 

Result：触发结果，0 代表成功，1 代表不成功； 

注意：该功能块需要在主站和从站通讯握手后一段时间，比如 5s 后调用才能成功；在未初始化完成时启用该功

能 Result 会返回错误码，需要等待重新触发该功能。 

3.11.5 PDO 写功能 

 

输入参数： 

NodeID：0-126，需要启用 PDO 的从站节点号；代表本机，0 模拟的是一个 CoDeSys 上的一个 CAN 从站； 

PDOIndex：0-3；代表 RPDO1-4；PDO 使用尽量少的路数为好，PDO 组数使用太多会占用较多总线负载率； 

Value1-4：需要写入到事先配置好的参数的数值； 

DataCount：实际使用的参数个数 1-4；例如 2 代表 Value1 和 Value2 有效。 

3.11.6 PDO 读功能 

 

输入参数： 

NodeID：0-126，需要启用 PDO 的从站节点号；代表本机，0 模拟的是一个 CoDeSys 上的一个 CAN 从站； 

PDOIndex：0-3；代表 RPDO1-4；PDO 使用尽量少的路数为好，PDO 组数使用太多会占用较多总线负载率； 

输出参数： 

Value1-4：读取的结果； 

DataCount：实际反馈的有效参数个数。 
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3.12 掉电参数保存功能 

需要使用掉电参数保存功能，需要在 Application 下右键添加 PersistantValue； 

定义的这种类型的变量在掉电前会自动保存到铁电中去并且在下次启动时读取保存的值。 

 

3.13 通讯断线检测功能 

1.我们采用了 CIA301 里的心跳时间来检测通讯的断线；默认是不开启该功能的，如需开启需调用下面的功能； 

有两个心跳时间，主站的心跳和从站的心跳； 

2.主站心跳用来告诉从站主站多长时间会来一个心跳；当从站 3 倍心跳时间内检测不到主站心跳，从站报警 26-0； 

3.从站心跳用来告诉主站从站多长时间会来一个心跳；当主站 3 倍心跳时间内检测不到从站心跳，主站报警 26-0； 

4.功能块说明 

 

输入参数： 

Enable：功能触发指令，上升沿触发该功能； 

SlaveHeartBeatTime：从站的心跳时间，单位 ms； 

MasterHeartBeatTime：主站的心跳时间，单位 ms； 

输出参数： 

Result：0 代表成功，1 代表不成功； 

注意：该功能块需要在主站和从站通讯握手后一段时间，比如 5s 后调用才能成功；在未初始化完成时启用该功

能 Result 会返回错误码，需要等待重新触发该功能。 

3.14 伺服报警或者断线保护 

设置了上面章节的心跳后伺服可以相互检测通讯是否正常，可以选择是否在检测到通讯有问题时自动停机；参数

P4.89CANopen 断线自动停机（从机也需要设置），选择使能； 

1. 设置后当通讯正常的情况下，PLC 检测到网络中任何一台伺服报警后，可以让所有伺服停机； 

2. 当主站（PLC）和其他伺服检测到通讯断线后，主站和从站都会自动停机。 

3.15 PLC485 参数操作 

1.需要通过 485 操作 PLC 参数需要将变量固定在某个地址；例如下图： 



英威腾 SV-DA200 伺服 CODESYS 软 PLC 技术指南 

4 

 

2.紫色部分还可以定义成%MWn，代表 16 位参数；%MDn 代表 32 位数； 

%MD0 和%MW2 在内存上是一个地址；定义时为避免地址重叠建议都定义成 32 位数据； 

3.数据起始 485 地址是 10000； 

上图中 PLCData1 的地址是 10000；PLCData2 地址为 10002；PLCData3 地址为 10004； 

4.通过串口工具或者其他串口软件对这几个地址读取或者设置就能对 PLC 内部变量进行操作。 
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4 软 PLC 功能块 

4.1 fbDAxxMAIN 

4.1.1 输入接口 

序号 输入名称 数据类型 初始值 功能说明 备注 

1 iIniteTime INT 200ms 功能块初始化时间设定  

2 iAxisAddress UINT - 驱动器的 CANOPEN 地址。本机是 0。  

3 iReadPDONum UINT 2 读取 PDO 数量(共计 4 组)  

4 iWritePDONum UINT 2 写入 PDO 数量(共计 4 组)  

5 iWritePDO0 UINT 3 第一组 PDO 数据个数  

6 iWritePDO1 UINT 2 第二组 PDO 数据个数  

7 iWritePDO2 UINT 1 第三组 PDO 数据个数  

8 iWritePDO3 UINT 0 第四组 PDO 数据个数  

9 iLimitPos BOOL - 正向极限 预留接口 

10 iLimitNeg BOOL - 反向极限 预留接口 

11 ifbPower fbPower - 使能功能块  

12 ifbHome fbHome - 回原点功能块  

13 ifbPosABS fbPosABS - 绝对定位功能块  

14 ifbPosREL fbPosRel - 相对定位功能块  

15 ifbVelocity fbVelocity - 速度功能块  

16 ifbTorque fbTorque - 转矩功能块  
 

4.1.2 输出接口 

序号 输入名称 数据类型 初始值 功能说明 备注 

1 qInitDone BOOL - 初始化完成  

2 qAxisMode INT - 伺服轴模式 
1：位置；2：速度；

3 转矩 

3 qAxisON BOOL - 伺服使能状态  

4 qAxisEstop BOOL - 伺服急停  

5 qAxisError BOOL - 伺服故障  

6 qAxisErrorCode INT - 伺服故障代码  

7 qAxisStandStill BOOL - 伺服静止  

8 qReadError BOOL - 读取 PDO 故障  

9 qWriteError BOOL - 写入 PDO 故障  

10 qActPosition DINT - 伺服轴实际位置  

11 qPositionDone BOOL - 伺服轴定位完成  

12 qPositionError BOOL - 伺服定位故障  

13 qPositionErrorCode INT - 伺服定位故障代码  

14 qActVelocity DINT - 伺服轴实际速度  
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15 qVelocityReached BOOL - 伺服轴速度到达  

16 qVelocityStep INT - 伺服轴速度故障代码  

17 qActTorque INT - 伺服轴实际转矩  

18 qActCurrent INT - 伺服轴实际电流  

19 qHomeDone BOOL - 伺服轴回零完成  

20 qHomeError BOOL - 伺服轴回零故障  

21 qHomeErrorCode INT - 伺服轴回零故障代码  
 

4.2 fbPower 

4.2.1 接口说明 

序号 输入名称 数据类型 初始值 功能说明 备注 

1 iEnable BOOL - 使能  

2 iAuxSwitch BOOL - 辅助开关接点  

3 iEstop BOOL - 急停  

4 iReset BOOL - 复位  
 

4.2.2 功能介绍 

 1. iAuxSwitch 和 iEstop 是常闭点。需要外部接常通信号。 

 2. 伺服轴无故障时，可以通过 iEnable，进行使能。如果伺服轴已经使能，可以通过 fbDAxxMAIN 内的

qAxisON 查看状态。若是’TRUE’则伺服已经使能，否则是’FALSE’。 

 3. 出现故障后，fbDAxxMAIN 内的 qAxisON 会变为’FALSE’。请先取出 iEnable 后，再通过 iReset 进行故

障复位。 

4.3 fbPosABS 

4.3.1 接口说明 

序号 输入名称 数据类型 初始值 功能说明 备注 

1 iExcute BOOL - 绝对定位触发信号  

2 iTargetPosition LINT - 绝对定位位置  

3 iVelocity LINT 200 绝对定位速度  

4 iNumerator LINT 1 绝对定位位置分子  

5 iDenominator LINT 1 绝对定位位置分母  

6 iAccDec INT 200 绝对定位加减速时间(ms)  
 

4.3.2 功能介绍 

此功能块是绝对定位功能块。如果，伺服轴执行过回原点功能，那么绝对定位是以回完原点后的位置为绝对

位置的参考点。否则是以电机的编码器为原点。 

 1. iTargetPosition 对应伺服参数 PTP0.01。 
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注意：iDenominator 不可以为 0。 

 2. iVelocity 对应 P5.21 参数。单位是：r/min。 

 3. iAccDec 对应 P5.37 参数。单位是：ms。 

4.4 fbPosREL 

4.4.1 接口说明 

序号 输入名称 数据类型 初始值 功能说明 备注 

1 iExcute BOOL - 绝对定位触发信号  

2 iTargetPosition LINT - 绝对定位位置  

3 iVelocity LINT 200 绝对定位速度  

4 iNumerator LINT 1 绝对定位位置分子  

5 iDenominator LINT 1 绝对定位位置分母  

6 iAccDec INT 200 绝对定位加减速时间(ms)  
 

4.4.2 功能介绍 

此功能块是相对定位功能块。相对定位仅仅是以当前位置为参考点，进行相对定位。 

 1. iTargetPosition 对应伺服参数 PTP0.01。 

 

 注意：iDenominator 不可以为 0。 

 2. iVelocity 对应 P5.21 参数。单位是：r/min。 

 3. iAccDec 对应 P5.37 参数。单位是：ms。 

4.4.3 绝对定位/相对定位故障代码信息 

序号 名称 故障代码 说明 

1 

qPositionErrorCode 

10 没有位置到达信号后者是正在执行上一个定位 

2 15 CanOpen 的运行模式不是 1。请检查设置。 

3 20 运行模式未使能，伺服轴故障，或者是急停信号 

4 25 
伺服没有执行动作，请检查是否是有其他运行功能块在执

行；或者重新触发，并检查参数配置部分。 
 

4.5 fbVelocity 

4.5.1 接口说明 

序号 输入名称 数据类型 初始值 功能说明 备注 

1 iExcute BOOL - 速度使能  

2 iVelocity LINT 200 点动速度  

3 iAcc INT 200 点动加速时间(ms)  

4 iDec INT 200 点动减速时间(ms)  
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4.5.2 功能介绍 

此功能块是速度功能块。如果需要反向速度时，需要将 iVelocity 更改为负值。 

 1. 速度单位：r/min。对应驱动器参数：P4.13。 

 2. 加速单位：ms。对应驱动器参数：P0.54。 

 3. 减速单位：ms。对应驱动器参数：P0.55。 

4.6 fbTorque 

4.6.1 接口说明 

序号 输入名称 数据类型 初始值 功能说明 备注 

1 iExcute BOOL - 速度使能  

2 iTargetTorque LINT 200 点动速度  

3 iTargetVelocity INT 200 点动加速时间(ms)  
 

4.6.2 功能介绍 

此功能块是转矩功能块。如果需要反向时，需要将 iTargetTorque 给负值即可。 

 1. 转矩单位：%。对应驱动器参数：P4.14。 

 2. 速度单位：r/min。对应驱动器参数：P0.46。 

4.7 fbHome 

4.7.1 接口说明 

序号 输入名称 数据类型 初始值 功能说明 备注 

1 iExcute BOOL - 使能回原点  

2 iHomeSpeed INT 100 回原点速度  

3 iHomeTorque INT 200 回原点转矩  

4 iHomeForward BOOL - 正方向回原点  

5 iHomeBackward BOOL - 反方向回原点  

6 iRtrig BOOL - 检测上升沿  

7 iFtrig BOOL - 检测下降沿  

8 iHomeSingle BOOL - 原点信号  

9 iZpuls BOOL - 回 Z 脉冲  

10 iPositionOffset DINT 0 原点位置偏差  

11 iEncoderPuls DINT 10000 编码器分辨率  

12 iSinglePuls DINT 10000 伺服轴一圈脉冲数  
 

4.7.2 功能介绍 

此功能块是回原点功能块。 

 回原点方式： 

1. 上升沿正向找 Z 信号 

2. 上升沿正向不找 Z 信号 
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3. 上升沿反向找 Z 信号 

4. 上升沿反向不找 Z 信号 

5. 下降沿正向找 Z 信号 

6. 下降沿正向不找 Z 信号 

7. 下降沿反向找 Z 信号 

8. 下降沿反向不找 Z 信号 

9. 无边沿正向找 Z 信号 

10. 无边沿正向不找 Z 信号 

11. 无边沿反向找 Z 信号 

12. 无边沿反向不找 Z 信号 

13. 双边沿正向找原点 

14. 双边沿反向找原点 

序号 名称 iRtrig iFtrig iHomeForward iHomeBackward iZpuls 

1 上升沿正向找 Z √ × √ × √ 

2 上升沿正向不找 Z √ × √ × × 

3 上升沿反向找 Z √ × × √ √ 

4 上升沿反向不找 Z √ × × √ × 

5 下降沿正向找 Z × √ √ × √ 

6 下降沿正向不找 Z × √ √ × × 

7 下降沿反向找 Z × √ × √ √ 

8 下降沿反向不找 Z × √ × √ × 

9 无边沿正向找 Z × × √ × √ 

10 无边沿正向不找 Z × × √ × × 

11 无边沿反向找 Z × × × √ √ 

12 无边沿反向不找 Z × × × √ × 

13 双边沿正向找原点 × × √ × √ 

14 双边沿反向找原点 × × √ × × 

注意： 

 1、回原点的方向只能是单个方向，不能同时选择或者不选择。如果全选或者全不选，那么会默认为正向找

原点。 

2、回原点方式只有上述 14 种，其余暂无。 

4.7.3 回原点故障报警 

序号 名称 故障代码 说明 

1 
qHomeErrorCode 

10 没有找到原点开关，请检查原点信号 

2 15 原点开关处于常接通状态，请检查原点信号 
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6 故障及诊断 

故障码 名称 原因 对策 

Er01-0 IGBT 故障 

驱动器实际输出电流超过规定值。

1.驱动器故障（驱动电路、IGBT 故

障）。 

2.电机电缆 U、V、W 短路、电机电

缆接地或接触不良。 

3.电机烧毁。 

4.电机线 U、V、W 相序接反。 

5.参数不合适导致系统发散。 

6.起停过程加减速时间太短。 

7.瞬间负载过大。 

1.拆除电机电缆，使能驱动器，如果仍

然发生故障则更换驱动器； 

2.检查电机电缆及接线是否良好； 

3.调小 P0.10、P0.11 使最大输出力矩

变小； 

4.调试环路参数使系统稳定，调小

P0.12 的值； 

5.将加减速时间适当设长； 

6.更换更大功率驱动器； 

7.更换电机。 

Er01-1 
制动管故障 

（7.5kW 及以上机型） 
制动的电流过大 

1.若使用内置制动电阻，那么请使用外

接制动电阻并且正确设置制动电阻参

数； 

2.若使用外置制动电阻，那么请检查相

应电阻参数设置是否正确； 

3.外接制动电阻阻值过小。 

Er02-0 编码器故障-编码器断线 
1.未接编码器。 

2.编码器插头松动。 

3.编码器信号线 U、V、W、A、B、

Z 相某根线断线。 

4.编码器 A/B 反相。 

5.主要由噪音引起的通信中断或数

据异常。 

6.编码器通信无异常，但通信数据异

常。 

7.负责与编码器通信的 FPGA 报通

信超时。 

8.驱动器不支持编码器类型 

1.按照接线方式正确连接编码器。检查

编码器插头解除是否良好。如果线缆断

开则更换编码器电缆； 

2.检测编码器电源电压是否正常； 

3.减少编码器线缆受干扰的条件，将编

码器连接线与电机电缆线分开布线，将

编码器线缆屏蔽线接入 FG； 

4.如果上电时报编码器断线故障，按参

数 P0.01 说明检查驱动器支持编码器

类型与电机编码器类型是否一致。 

Er02-1 
编码器故障-编码器反馈

误差过大 

Er02-2 
编码器故障-奇偶校验错

误 

Er02-3 
编码器故障-CRC 校验错

误 

Er02-4 编码器故障-帧错误 

Er02-5 编码器故障-短帧错误 

Er02-6 
编码器故障-编码器报超

时 

Er02-7 
编码器故障-FPGA 报超

时 

Er02-8 
编码器故障-编码器电池

低压报警 

使用多圈绝对值编码器时，外接编码

器电池电压介于 3.0V~3.2V 之间时。

1.检查编码器电缆中电池连接是否良

好； 

2.使用万用表测量编码器外接电池电

压是否低于 3.2V，如果真实的电压低

于 3.2V，可以考虑更换电池； 

3.更换电池请在驱动器上电的情况下

执行，否则编码器绝对数据会丢失。

Er02-9 
编码器故障-编码器电池

欠压故障 

使用多圈绝对值编码器时，外接编码

器电池电压介于 2.5V~3.0V 之间时。

1.检查编码器电缆中电池连接是否良

好； 
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2.使用万用表测量编码器外接电池电

压是否低于 3.0V，如果真实的电压低

于 3.0V，则必须更换电池； 

3.更换电池请在驱动器上电的情况下

执行，否则编码器绝对数据会丢失。

Er02-a 编码器故障-编码器过热 
编码器反馈温度高于设定的过热保

护值。 

1.确认编码器过热保护值设定是否正

确。 

2.使电机停止工作，给编码器降温。 

Er02-b 
编码器故障-编码器

EEPROM 写入错误 

电机搭配通信式编码器时，驱动器向

编码器 EEPROM 更新数据时，发生

通信传输错误或数据校验错误。 

1.检查编码器线缆连接是否良好，减少

编码器通信受干扰的情况； 

2.尝试多次写入，如果多次报故障则请

更换电机。 

Er02-c 
编码器故障-编码器

EEPROM 无数据 

电机搭配通信式编码器时，上电时读

取编码器 EEPROM 时无数据。 

1.通过 P0.00 选择当前电机型号，然后

通过 P4.97 参数执行编码器 EEPROM

参数写入操作； 

2.通过 P4.98 参数屏蔽该故障，此时使

用驱动器EEPROM中的电机参数进行

相应的初始化。 

Er02-d 
编码器故障-编码器

EEPROM 数据校验错误 

电机搭配通信式编码器时，上电时读

取编码器 EEPROM 时，发生数据校

验错误。 

1.检查编码器线缆连接是否良好，减少

编码器通信受干扰的情况； 

2.通过 P0.00 选择当前电机型号，然后

通过 P4.97 参数执行编码器 EEPROM

参数写入操作，更新编码器 EEPROM

中的数据； 

3.通过 P4.98 参数屏蔽该故障，此时使

用驱动器EEPROM中的电机参数进行

相应的初始化。 

Er03-0 
电流传感器故障-U 相电

流传感器故障 

1.电流传感器或检测电路异常。 

2.电机轴处于非静止状态时上电。 

在电机静止状态下重新上电，如果多次

报出故障则更换驱动器。 
Er03-1 

电流传感器故障-V 相电

流传感器故障 

Er03-2 
电流传感器故障-W 相电

流传感器故障 

Er04-0 系统初始化故障 
系统上电初始化过程完成后，有自检

未通过项。 

1.重新上电； 

2.如果反复多次发生，则需更换驱动

器。 

Er05-1 
设置故障-电机型号不存

在 
P0.00 参数设置错误 

1.确认电机型号设定是否正确； 

2.确认电机参数型号与驱动器功率等

级匹配。 Er05-2 
设置故障-电机和驱动器

型号不匹配 
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Er05-3 
设置故障-软件限位设置

故障 

软件限位值设定不合理。 

P0.35（正向位置控制软件限位）设

定值小于等于 P0.36（反向位置控制

软件限位）设定值。 

重新设定 P0.35、P0.36。 

Er05-4 
设置故障-回原点模式设

置故障 
P5.10 模式设置错误 根据参数详细说明正确设定 P5.10。

Er05-5 
设置故障-点位控制行程

溢出故障 
点位空行程单次增量超过（231-1）

确认绝对位置模式下，单次行程不能超

过（231-1）。 

Er07-0 再生放电过载故障 

1.制动电阻功率较小。 

2.电机转速过高或减速过快，无法在

规定时间内完全吸收再生能量。 

3.外接制动电阻动作极限被限制在

10%占空比。 

1.将内接制动电阻改为外接制动电阻

并增大功率； 

2.修改减速时间，降低再生放电动作

率； 

3.降低电机转速； 

4.提高电机、驱动器容量。 

Er08-0 
模拟输入过压故障-模拟

量速度指令 

1.输入到模拟量速度指令端口的电

压超过 P3.22 的设定值。 

2.输入到模拟量转矩指令端口的电

压超过 P3.25 的设定值。 

3.输入到模拟量输入 3 端口的电压

超过 P3.75 的设定值。 

1.正确设定 P3.22、P3.25、P3.75；

2.检查端子接线是否良好； 

3.设定 P3.22、P3.25、P3.75 为 0，使

保护功能无效。 

Er08-1 
模拟输入过压故障-模拟

量转矩指令 

Er08-2 
模拟输入过压故障-模拟

量输入 3 

Er09-0 EEPROM 故障-读写故障 

从 EEPROM 读取数据时，参数保存

区的数据损坏。 

EEPROM 写操作时受干扰。 

1.重新上电后重试； 

2.如果反复多次发生，则需更换驱动

器。 

Er09-1 
EEPROM 故障-数据校验

故障 

1.上电时从 EEPROM 读出的数据与

写入时的不同。 

2.驱动器 DSP 软件版本更新。 

1.重新设定所有参数； 

2.如果反复多次发生，则需更换驱动

器。 

Er10-0 硬件故障-FPGA 故障 控制板上的 FPGA 芯片报故障 

1.重新上电； 

2.如果反复多次发生，则需更换驱动

器。 

Er10-1 硬件故障-通信卡故障 外接通信卡报故障。 

1.重新上电； 

2.如果反复多次发生，则需更换通信

卡。 

Er10-2 硬件故障-对地短路故障 
驱动器上电时，对地短路检测中，电

机电缆 V、W 中的某一相对地短路。

1.检查电机电缆是否连接正常； 

2.更换电机电缆或检测电机是否绝缘

老化。 

Er10-3 硬件故障-外部输入故障 
当配置为外部故障输入功能的开关

量端子动作时产生该故障。 

1.解除外部故障输入，使能故障清除；

2.驱动器重新上电。 

Er10-4 硬件故障-紧急停机故障 
当紧停按钮动作（配置为紧急停机功

能的开关量端子）时产生该故障。

1.解除紧急停机输入，使能故障清除；

2.驱动器重新上电。 

Er10-5 硬件故障-485 通信故障 当 485 通信线路上电磁干扰太强烈，1.485 通信使用带屏蔽的双绞线进行
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导致驱动器串口通信报警。 布线； 

2.将通信线缆与电机动力线进行分开

排布。 

Er11-0 
软件故障-电机控制任务

重入 1.DSP 软件 CPU 负载率过高。 

2.DSP 软件有缺陷。 

1.减少一些不必要的软件功能； 

2.联系客服，更新驱动器 DSP 软件。Er11-1 软件故障-周期任务重入 

Er11-2 软件故障-非法操作 

Er12-0 
IO 故障-开关量输入分配

重复 

有两个或以上的开关量输入配置为

相同的功能。 

重新设定参数 P3.00~P3.09，确保没有

重复的设定。 

Er12-1 
IO 故障-模拟量输入分配

重复 

驱动器为标准机型时，模拟量输入 3

配置为速度指令。 

将参数 P3.70（模拟量输入 3 功能）配

置为其它值。 

Er12-2 
IO 故障-脉冲输入频率过

高 

驱动器检测到的脉冲输入频率高于

规定值。 

1.外部输入脉冲信号频率过高。 

2.驱动器内部脉冲频率检测电路损

坏。 

1.降低外部输入脉冲信号频率； 

2.如果外部输入信号正常时仍然报故

障，则需更换驱动器。 

Er13-0 主回路过压故障 

驱动器检测主回路直流电压超过规

定值。 

1.电网电压偏高。 

2.制动工况下未接制动电阻或制动

管、制动电阻损坏。 

3.停机过程中减速时间太短。 

4.驱动器内部直流电压检测电流损

坏。 

1.检测电网输入电压是否超过允许值；

2.检查内置制动电阻短接线是否松动

或检测内置制动电阻是否损坏。检测外

接制动电阻是否损坏； 

3.加长减速时间设定值； 

4.在驱动器不使能情况下监测参数

R0.07 是否正常，如果异常并且与电网

输入电压不匹配，则需更换驱动器。

Er13-1 主回路欠压故障 

驱动器检测主回路直流电压低于规

定值。 

1.电网电压偏低。 

2.上电缓冲继电器未吸合。 

3.驱动器输出功率过大。 

4.驱动器内部直流电压检测电路损

坏。 

1.检测电网输入电压是否低于允许值；

2.重新上电，注意听取是否有上电缓冲

继电器是吸合的响声； 

3.在驱动器不使能情况下监测参数

R0.07 是否正常，如果异常并且与电网

输入电压不匹配，则需更换驱动器。

Er14-0 控制电源欠压故障 

驱动器检测控制电源直流电压低于

规定值。 

1.电网电压偏低。 

2.驱动器内部控制电源直流电压检

测电路损坏。 

1.检测电网输入电压是否低于允许值；

2.在驱动器不使能情况下监测参数

R0.08 是否正常，如果异常并且与电网

输入电压不匹配，则需更换驱动器。

Er17-0 驱动器过载故障 驱动器短时负载过重 

1.负载太大，导致驱动器过载； 

2.检查电机的 UVW 接线有无错相、缺

相，以及编码器是否正确； 

3.检查电机与驱动器是否匹配。 
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Er18-0 电机过载故障 
1.长时间超负荷运行； 

2.短时间负载过重。 
1.更换更大功率驱动器和电机。 

Er18-1 电机过温故障 电机温度超过保护值。 
1.更换更大功率的电机； 

2.检查 UVW 相序是否正确。 

Er19-0 速度故障-过速故障 

电机转速绝对值超过 P4.32 设定值。

1.电机飞车，电机 U、V、W 相序接

反。 

2.电子齿轮比或电机速度环控制参

数设定不合理。 

3.参数 P4.32 设定值小于 P4.31（最

大速度限制）。 

4.编码器反馈信号受干扰。 

1.检查电子齿轮比参数设定是否合理；

2.检查速度环控制参数设定； 

3.检查电机线相序是否正确； 

4.检查电机编码器线连接是否良好； 

5.更换更高转速的电机。 

Er19-1 速度故障-正向过速故障 
速度反馈大于 P4.40 超过 20ms 时

间。 

1.确认编码器是否正常； 

2.P4.40 参数设置是否合理。 

Er19-2 速度故障-反向过速故障 
速度反馈大于 P4.41 超过 20ms 时

间。 

1.确认编码器是否正常； 

2.P4.41 参数设置是否合理。 

Er19-3 
速度故障-过速参数设置

错误 

P4.40 设置小于 0，或者 P4.41 设置

大于 0。 

1.检查编码器是否可靠连接； 

2.P4.40 或 P4.41 参数设置是否错误 

Er20-0 速度超差故障 

非转矩模式下，电机转速与转速指令

的偏差超过 P4.39 设定值。 

1.电机 U、V、W 相序接反或未接电

机线。 

2.电机负载过重导致电机卡死堵转。

3.驱动器出力不足导致电机卡死堵

转。 

4.速度环控制参数设定不合理。 

5.参数 P4.39 设定值过小。 

1.检查电机线相序，正确接线； 

2.检查传送皮带或链条是否太紧或者

工作台是否到达边界或遇到障碍物；

3.检查环路控制参数是否设置合适或

者驱动器是否损坏或者伺服系统是否

选型合适； 

4.将 P4.39 设定值变大； 

5.将 P4.39 设为 0，使速度超差故障检

测无效。 

Er21-0 位置超程-正向超程 

位置模式或全闭环模式下，碰到正向

极限开关或者反馈脉冲累计超过

P0.35。 

1.检查正向极限开关信号是否正确； 

2.检查 P0.35 设置是否合理。 

Er21-1 位置超程-反向超程 

位置模式或全闭环模式下，碰到反向

极限开关或者反馈脉冲累计超过

P0.36  

1.检查反向极限开关信号是否正确； 

2.检查 P0.36 设置是否合理。 

Er22-0 超差故障-位置超差 

1.伺服响应时间太慢导致滞留脉冲

数值超过 P4.33 设定值。 

2.电机负载过重导致电机卡死堵转。

3.脉冲输入频率过高，超过电机最高

转速能力。 

4.位置指令输入阶跃变化量超过

P4.33 设定值。 

1.检查传送皮带或链条是否太紧或者

工作台是否到达边界或遇到障碍物；

2.将位置环增益参数设大或将速度前

馈增益设大，也可以将位置超差脉冲范

围（P4.33）设大； 

3.调整电子齿轮比参数； 

4.调小位置指令输入变化量。 
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Er22-1 
超差故障-混合控制偏差

过大 

在全闭环控制时，光栅尺的反馈位置

与编码器的反馈位置偏差超过

P4.64 设定值。 

1.检测电机与负载的连接； 

2.检查光栅尺与驱动器的连接； 

3.检查光栅尺分子、分母（P4.60、

P4.61），光栅尺方向反转（P4.62）设

定是否正确。 

Er22-2 位置增量溢出故障 
经过电子齿轮比转换后单次变化的

位置指令超过（231-1）。 

1.减小位置指令的单次变化量； 

2.修改电子齿轮比至合适的范围。 

Er22-3 同步信号超时 

Interpolation position mode 下，相

邻两个同步帧信号之间的时间间隔

超过了 2 倍的通信时间周期。 

1.检查通信线路，提高通信可靠性； 

2.确认同步信号发生源的同步帧发生

间隔是否正确。 

Er22-4 位置指令缓冲满 CANopen 点位位置指令缓存满 加长点位位置指令发送的时间间隔 

Er23-0 驱动器过温故障 

1.驱动器使用的环境温度超过规定

值。 

2.驱动器过载。 

1.降低驱动器的使用环境温度，改善通

风环境。 

2.更换更大功率伺服系统。 

3.延长加减速时间，降低负载。 

Er25-4 
应用故障-编码器偏置角

度测试超时 

编码器偏置角度测试过程中出现异

常。 

检查电机轴是否能够自由转动，重上电

后再执行。 

Er25-5 
应用故障-编码器偏置角

度测试失败 

编码器偏置角度测试过程中电流反

馈波动较大。 

尝试减小 P4.53 参数设置，重上电后

再执行。 

Er25-6 应用故障-回原点越位 
回原点过程中遇到极限开关或软件

限位。 

修改参数 P5.10 的设置，重上电后再

执行。 

Er25-7 应用故障-惯量辨识失败 

1.惯量辨识电机停止转动时有 3.5s

以上的抖动。 

2.辨识实际加速时间太短。 

3.辨识速度低于 150r/min。 

1.电机停止运行时抖动可适当提高机

械刚性。 

2.增大加速时间常数 P1.07。 

3.增大可动范围 P1.06。 

Er26-0 CANOpen 断线 
主站一段时间未收到从站的心跳报

文。 
检查通信连线。 

Er26-1 SDO 索引不存在 

SDO 读或者写参数，对应的索引在

对象字典中不存在或者本驱动器不

支持。 

核对主站查询的索引和本驱动器支持

的索引，并对 EDS 文件进行修改。 

Er26-2 SDO 子索引不存在 

SDO 读或者写参数，对应的索引在

对象字典中存在但子索引在对象字

典中不存在或者不支持该子索引。

核对主站查询的索引和子索引和本驱

动器支持的索引和子索引，并对 EDS

文件进行修改。 

Er26-3 SDO 数据长度错误 

SDO 读或者写命令中的长度信息和

驱动器对象字典里的数据长度不匹

配。 

根据驱动器对象字典中数据的长度调

整 SDO 读写命令的长度。 

Er26-4 SDO 写数据超出范围 
SDO 写数据的范围超过驱动器对象

字典里的数据范围。 

根据对象字典里的数据范围调整 SDO

写入的数据的大小。 

Er26-5 只读不能修改 试图修改只读参数。 检查是否有写只读参数的情况。 

Er26-6 PDO 映射长度错误 PDO 映射的数据总长度超过 64 位。检查对应的 PDO 映射总长度。 
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故障码 名称 原因 对策 

Er26-7 PDO 映射数据不存在 
PDO 映射的数据在对象字典中找不

到对应参数。 

检查 PDO 映射索引和子索引是否在对

象字典中存在。 

Er26-8 
PDO 不允许在操作态修

改 
试图在操作态修改 PDO 映射。 

将 CANOpen 状态机切换到预操作台

再进行 PDO 映射的修改。 

Er26-9 PDO 不允许映射 
试图将不允许映射的参数映射到

PDO 中去。 

检查 PDO 参数的属性是否有只读的而

映射到 RPDO 中去的。 

Er26-a 同步信号过快 
同步工作模式下，从站收到的帧数超

过了波特率允许的范围。 

1.修改主站发送的数据帧间隔或同步

帧的时间间隔； 

2.修改通信波特率。 

Er26-b 接收故障 
CAN 通信断线或接收错误计数器超

过 128。 

1.检查通信连线； 

2.重启伺服驱动器； 

Er26-c 发送故障 
CAN 通信断线或发送错误计数器超

过 128。 

1.检查通信连线； 

2.重启伺服驱动器； 

Er26-d 同步信号重复 
在配置从站产生同步信号的情况下，

同时收到了外部输入的同步信号。

修改配置，确认一个通信网络内只有一

个同步信号产生源。 

Er26-e 总线负载率过高 
异步工作模式下，从站收到的帧数超

过了波特率允许的范围。 

1.修改主站发送的数据帧的时间间隔；

2.修改从站 TPDO 的发送模式； 

3.修改通信波特率。 

Er26-f 参数修改状态错误 
SDO 在非允许修改状态下试图修改

参数 

先调整 CANopen 状态机至 Pre-OP 或

OP 状态，再尝试修改参数。 
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